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KATA PENGANTAR 
 
 

 

Pemrograman Visual merupakan model pemrograman yang akhir-akhir ini populer 

di lingkungan Windows. Salah satu perangkat lunak yang berbasis pemrograman 
visual adalah Visual FoxPro. Dengan men ggunakan perangkat lunak ini pembuatan 
program aplikasi yang melibatkan basis data dapat dilakukan dengan mudah dan cepat. 
Antarmuka yang menarik dan mudah dipakai dapat dibuat secara visual dan tanpa harus 
banyak menuliskan kode. Laporan, menu, dan hal-hal lain yang erat kaitannya dengan 
suatu aplikasi juga dapat dibuat dengan mudah sehingga akan terasa sekali bahwa 
Visual FoxPro dapat meningkatkan produktivitas pemrogram. 

Dengan menggunakan pendekatan belajar sambil mencoba, buku ini dimaksudkan 
agar Mahasiswa Universitas 19 November (USN) Kolaka pada umumnya dan 
Program Studi Sistem Informasi pada khususnya mampu dengan mudah dapat mem-

pelajari perangkat lunak Visual FoxPro sekalipun belum memiliki pengalaman 
memprogram di lingkungan Windows. Dalam buku ini penulis sengaja memberikan contoh 
yang sederhana namun sangat berguna untuk di aplikasikan dalam hal urusan 

administrasi berbsais database. Dari contoh yang sederhana ini, penulis berharap buku ini 
dapat diterima oleh semua kalangan khususnya Mahasiswa USN Kolaka demi kelancaran 

proses belajar mengajar secara teori mapun praktek. 

Dalam penulisan buku ini penulis sangat menyadari masih terdapat banyak 

kekurngan yang kemudian penulis mengharapkan masukan-masukan, saran dan kritik 
pembaca untuk dijadikan acuan perbaikan pada penulisan buku ini. 

Akhir kata, penulis berharap buku ini dapat membantu para pemrogram yang 
tertarik untuk membuat aplikasi dengan pendekatan visual. Penulis juga berharap akan 
adanya saran dari pembaca. Tidak lupa, penulis mengucapkan terima kasih kepada 
semua pihak atas segala ide. saran, dorongan, dan bantuan, yang memungkinkan buku 
ini terwujud. 

 

 

 

 

Kolaka, September 2008 

Penulis 
 
 

Qammaddin, S.Kom 
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1.  PENDAHULUAN 

 
 

1.1. Apakah Bahasa Pemrograman Microsoft Visual FoxPro itu ? 
 

Miscrosoft Visual FoxPro adalah suatu sistem aplikasi pengolahan data base dengan 

menggunakan pemrograman under windows. FoxPro diciptakan untuk mendukung pemrograman 
berorientasi objek atau Object Oriented Programming (OOP). Untuk dapat melakukan OOP kita 

harus mengubah paradigma kita daiam memandang program. Jika sebelumnya kita memandang 
program sebagai serangkaian instruksi yang disusun daiam bentuk procedure/fungsi, maka 
dengan OPP kita harus memandang program sebagai serangkaian instruksi yang tersimpan dalam 

sekumpulan objek, dimana masing-masing objek memiliki data dan procedure (fungsi tersendiri). 
Data daiam objek disebut dengan Propertis, sedangkan Procedure / Fungsi dalam objek disebut 

Method. 
Pembahasan pembuatan program dilakukan secara berurutan langkah perlangkah yang 

dimulai dari tingkat dasar yaitu persiapan awal pembuatan suatu sistem aplikasi persiapan tabel 

sampai pada perancangan sistem menu dan kompilasi program yang jadi file exe yang bisa di 
eksekusi/dipangggil dari luar microsoft FoxPro dengan studi kasus Data Mahasiswa Baru 

Universitas 19 November Kolaka sehingga dapat memenuhi sebagian dari kebutuhan 
pihak manajemen secara cepat akurat den tepat waktu maka dibutuhkan suatu sistem program 

aplikasi data bebasis komputer yang andal. 
 

 

1.2. Batasan - Batasan. 
 

Pembuatan program yang akan dibuat untuk memberikan contoh pemrograman 
aplikasi jadi dengan menggunakan Visual Foxpro. Jadi belum membahas secara lengkap 

keseluruhan sistem informasi untuk Data Mahasiswa. Batasan sistem aplikasi yang dibuat meliputi 

konsep sistem secara umum yaitu Input, Preses dan Output. 
1.  Masukan Sistem ( Input) 

Nomor Stambuk Mahasiswa (stb) memberikan informasi satu record data mahasiswa. Jika 
anda ingin menggunakan contoh kasus yang lain seperti penjualan atau persediaan, maka 

masukan sisitem/input yang digunakan harus disesuaikan dengan program aplikasi anda 
tersebut. Sebagai contoh : data barang. 

2.  Prosedur Sistem ( Proses) 

- proses pembuatan formulir input data awal, merupakan kegiatan perancangan formulir 
input dari awal menyangkut bagaimana bentuk tampilan (form input) 
proses pengisian data yang diperlukan. Merancang proses pengisian data kedalam 
formulir menyangkut validasi data ( tidak boleh ada kode yang dimasukan dua 

kali/redudansi ) dsb. 

- Proses pembuatan laporan, merancang pembuatan laporan sistem aplikasi     
      berdasarkan masukan sistem ( input }  

3. Keluaran Sistem (Output) 
Batasan untuk keluaran sistem ( output ) meliputi 

- Output dalam bentuk Video Display Monitor / Preview ( cetak ke layer ) 

- Output dalam bentuk dokumen kertas (cetak ke printer) 
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2. PENGENALAN OBJEK DAN  
MENU  RANCANGAN 
INTERFACE PEMROGRAMAN 

VISUAL FOXPRO   
 

  
 Komponen Objek  

 
Rancangan interface pada Bahasa Pemrograman Visual FoxPro membutuhkan objek-objek 

perintah. Setiap Objek selalu memiliki 3 komponen sebagai berikut  : 
 

1. Properties 

Properties merupakan karaktreristik atau sifat dari sebuah objek. Contoh Properties sbb : 
 

Properties Keterangan 

Name Nama Objek 

Caption Keterangan dari objek/teks yang ditampilkan pada objek 

Enabled Mentukan apakah objk bisa digunakan atau tidak 

 
2. Event 

Setiap objek mengenal dan dapat memberikan respon terhadap kejadian tertentu dalam 

program. Kejadian tersebut disebut dengan Event. Event digubakan untuk menentukan 
jalannya program (Algoritma) dalam Pemrograman Visual. Contoh Event sbb: 

 

Event Keterangan 

Load Dikerjakan disaat objek akan ditampilkan dalam program 

Activate Dikerjakan disaat objek diaktifkan dalam program 

Click Dikerjakan disaat objek di Click (Klik Kiri) 

Interactive Change Dikerjakan disaat isi objek dilakukan perubahan 

 

3. Method 
Untuk melakukan sebuah proses dibutuhkan instruksi atau perintahyang menentukan apa yang 

akan dikerjakan. Kumpulan instruksi tersebut disebut dengan Method. 
 

Bagaimana memulai Bahasa Pemrograman Vusual Foxpro ? 

1. Klik tombol start pada bagian kiri layar monitor anda (taskbar pada sistem windows 98/xp) 
2. Pilih menu program 

3. Klik menu/icon Microsoft Visual FoxPro (Lihat gambar 1) 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 
 

 
Gambar 2. 1. Shortcut Microsoft Visual Foxpro 
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Selanjutnya akan tampil layar utama program Microsoft Visual Foxpro. Seperti yang terlihat pada 

Gambar 2.2. 
 

 
 
 

 
 

 
 

 

 
 

 
 

 
 

 

 
 
 

Gambar 2. 2. Layar Utama program Visual Foxpro 
 

 

Tampilan tersebut tidak selamanya sama dikarenakan ada beberapa toolbar tidak aktif atau setting 
yang telah diubah sesuai kebutuhan. 

Secara lengkap, tampilan layar utama Bahasa Pemrograman Visual FoxPro yang sering kita jumpai 
saat melakukan design interface dapat dilihat pada gambar 3 

 

 
 

 
 

 

 
 

 
 

 
 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

Gambar 2. 3. Layar utama Design Program 

Menu Utama Menu Toolbar Form Control Project Manager Command Windows 

Form Designer Control Polate Properties 
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2.2  Menu Visual FoxPro 

 

 
1. Menu Utama (Menu Bar) 

Baha Pemrograman Visual FoxPro memiliki menu bar yang merupakan menu utama 
program. Menu bar tersebut terdiri atas : File, Edit, View, Format, Form, Tools, 
Program, Windows, Help. 

 
2. Menu Toolbar 

Menu Toolbar adalah menu yang terdiri atas sekumpulan tombol perintah (command 
button) yang berfungsi sebagai tombol cepat untuk menjalankan suatu perintah 

 

 
 

 
 

Gambar 2. 4. Layar Menu Toolbar 
 

3. Form Control Toolbar 

Seperti menu Toolbar, Form Control Toolbar juga berisikan sekumpulan tombol perintah 
(command button). Toolbar ini nantinya banyak kita gunakan dalam membuat (design) 

program aplikasi. Gambar berikut menunjukan Form Control Toolbar Bahasa Pemrograman 
Visula FoxPro. Secara standar, artinya control atau toolbar yang ada pada form tersebut 

dapat kita tambah jika dibutuhkan. 

 
 

 
 

 
Gambar 2. 5. Form Control Toolbar 

 

4. Color Palatte Toolbar 
Color Palette Toolbar berfungsi untuk mengatur pewarnaan pada jenis tulisan/teks 

maupun latar belakang 
 
 

 
 

 
 

 
 

 
 

 

Gambar 2. 6. Color Palette Toolbar 
 

 
 

5. Properties 
Properties adalah sarana untuk mengatur sifat (properties) dari form atau control-kontrol. 

Setiap kita memilih suatu objek atau control, maka isi dari properties ini akan berubah 
sesuai objek yang kita pilih 
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Gambar 2. 7. Properties 
 

6. Command Windows (Jendela Perintah) 

Melalui fasilitas ini, adana dapat mengetikan perintah pemrograman secara langsung 
seperti pada Bahasa Pemrograman xBase lainnya 

 

 
 

 
 

 
 

 

 
Gambar 2. 8. Command Windows 

 

7. Project Manager 

Pada bagian Project Manager diletakkan semua basis Pemrograman, Database, Form, 
Report, Class, Other, Code Program sehingga satu kesatuan yang teroganisir. 
 

 

 

 
 

 
 

 

 
 

 
 

 
 

 
 
 

 
 

 

Gambar 2. 9. Project Manager 
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8. Form Designer 

Form (formulir) merupakan lembar kerja yang digunakan untuk membuat design pengisian 

atau pengolahan data pada Visual FoxPro. Pengisian data pada Visual Foxpro sebenarnya 
bisa dilakukan lewat jendela browse akan tetapi untuk melakukan proses perhitungan atau 

proses pencarian data harus dilakukan diluar jendela browse lalu hasilnya di input kembali. 
Untuk mengurangi tugas operator untuk menghitung atau mencari data, salah satu cara 
pemecahannya  dalam visual FoxpPro yaitu dengan melakukan pengisian data lewat form 

karena dalam form tugas operator hanya melakukan pengisian data saja, sementara untuk 
proses menghitung atau mencari data bisa dilakukan secara otomatis . hal ini disebabkan 

karena dalam form terdapat penulisan kode program yang berhubungan dengan proses 
yang dinginkan. 

 

 
 

 
 

 
 

 

 
 

 
 

 
 

Gambar 2. 10. Form Designer 
 

2.3  Mengenal Objek Kontainer 

 
Ada empat macam container yang dapat kita tambahkan ke dalam sebuah form, yakni : 

 
• CommandGroup 
• OptionGroup 
• Grid 
• PageFrame 
 

1. Kontainer Grup Perintah 

Objek grup perintah (CommandGroup) adalah objek yang tersusun dari sejumlah objek 
tombol perintah (CommandButton). Objek CommandButton merupakan suatu tombol 
untuk memicu eksekusi suatu perintah tertentu. 
 

 
 

 

 
 

Gambar 2. 11. Kontainer Grup Perintah 
 

2. Kontainer Grup Opsi 

Objek grup opsi (OptionGroup) adalah sekelompok tombol yang digunakan untuk memilih 
suatu pilihan diantara sejumlah pilihan tertentu. 

 
 

 
 

 

Gambar 2. 12. Form Designer 
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3. Kontainer Grid 

Grid merupakan objek yang berfungsi untuk menampilkan table/view dalam bentuk baris 
kali kolom seperti tampilan jendela Browse. 
 

 
 

 
 

 

 
 

Gambar 2. 13. Form Designer 
 

4. Kontainer Bingkai Halaman 

Container bingkai halaman (PageFrame) berfungsi untuk menciptakan objek Page atau 
halaman. Sebuah halaman pada hakikatnya adalah suatu kotak dialog yang dapat 

digunakan seperti sebuah form tersendiri 
 

 
 

 
 

 

 
Gambar 2. 14. Form Designer 

 
Menambahkan Objek Kontainer ke dalam Form 

 
1. Pada menu utama Form Designer, pilih View dan kemudian pilih Form Control seperti pada 

gambar dibamwah ini. 

 
 

 
 

   CommandGroup    OptionGroup   Grid  PageFrame 
 

Gambar 2. 15. Kotak Dialog Form Kontrol 

 
2. Pada kotak Dialog Form Kontrol, klik toolbar objek container yang ingin ditambahkan 

(CommandGroup, OptionGroup, Grid atau PageFrame). 
3. Gerakkan Mouse kedalam daerah layout form dan klik untuk menambahkan objek. 
4. objek yang ditambahkan sekarang akan tampak dalam daerah layout form. Kita kemudian 

dapat mengubah ukuran objek maupun mengubah lokasi objek tersebut dngan mouse. 
Contoh : 

 
 

 

 
 

 
 

Gambar 2. 16.  

Kotak Dialog Form Kontrol 
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2.4  Mengenal Objek Kontrol 

 

Control-kontrol yang lazim ditambahkan kedalam form adalah sebagai berikut  : 
• ComboBox 
• CommandButton 
• EditBox 
• Image 
• Label 
• Line 
• ListBox 
• Shape 
• Spinner 
• TextBox 
• Timer 
 

 

1. Kontrol Kotak Kombo 

Objek kotak kombo (ComboBox) adalah sebuah kotak yang bila dipilih akan menampilka 
sebuah daftar pilihan. Kita kemudian dapat memilih satu pilihan dari daftar pilihan yang 

ada dengan menyorot pilihan tersebut. 
 

 

 
 

Gambar 2. 17. ComboBox 
 

2. Kontrol Tombol Perintah 

Objek tombol perintah (CommandButton) merupakan suatu tombol yang digunakan untuk 
memicu eksekusi suatu perintah tertentu. 

 
 

 
 

Gambar 2. 17. CommandButton 

 
3. Kontrol Gambar/Citra 

Objek Citra (Image) merupakan suatu daerah segi empat yang digunakan untuk 
menampilkan file gambar berekstensi. 

 
 
 

 
 

 

 
 

Gambar 2. 18. Image 
 

4. Kontrol Label. 
Label merupakan suatu objek yang digunakan untuk menampilkan teks pada form. 

Biasanya objek ini digunakan untuk memberi keterangan kepada field-field yang sedang 

diedit pada form. 
 

 
 

 

Gambar 2. 19. Label 
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5. Kontrol Garis 

Objek Garis (Line) merupakan suatu objek yang digunakan unuk menampilkan bentuk 
geometri garis pada form 
 

 
 
 

 
 

Gambar 2. 20. Line 
 

6. Kontrol Kotak List 

Objek Kotak List (ListBox) merupkan satu daerah segi empat pada form yang  digunakan 
untuk menampilkan daftar sejumlah pilihan tertentu. Berbeda dengan kotak kombo dimana 

objek harus dipilih terlebih dahulu untuk memunculkan daftar pilihan, pada kotak list daftar 
pilihan akan muncul secara otomatis saat objek ditampilkan. 

 
 

 

 
 

 
 

 

Gambar 2. 22. ListBox 
 

7. Kontrol Bentuk Geometri 
Objek bentuk Geometri (Shape) merupakan suatu objek yang digunakan untuk 

menampilkan bentuk Geometri segi empat dan elips. 
 

 

 
 

 
 

Gambar 2. 23. Shape 

 
8. Kontrol Spinner 

Spiner mirip sebuah kotak kombo,. Namun, berbeda dengan kotak kombo yang dapat 
menerima sembarang tip data, spinner khusus digunakan untuk mengolah data numeric. 

Kekhasan spinner adalah kita dapat menaikkan dan menurunkan nilai numeric 

spinnerdengan mengklik control yang ada disebelah kanan kotak spinner. 
 

 
 

 
Gambar 2. 24. Spinner 

 

9. Kontrol Kotak Teks 
Objek Kotak teks (TextBox) merupakan suatu daerah segi empat yang digunakan untuk 
mengedit text yang berukuran kecil, misalnya field karakter.  
 

 

 

 
      Gambar 2. 25. TextBox 
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10. Kontrol Jam 
Objek jam (Timer) merupakan objek yang unik. Objek ini bila ditambahkan kedalam suatu 
form akan memberikan form fasilitas untuk membaca waktu system. Saat form dijalankan, 

objek ini sendiri tidak akan kelihatan dilayar. 
 
 

 
 

 
 

Gambar 2. 26. Timer 

 
Menambahkan Objek Kontrol ke dalam Form 

 
Pada prinsipnya sama dengan menambah kan container kedalam form. 

Berikut ini mrnunjukan gambaran layout form yang mungkin terjadi saat kita menambahkan 
objek ComboBox, TextBox, Spinner, ListBox, Line, Shape, dan CommandButton. 
 

 
 

  
 

 

 
  

 
 

 
 

 

 
 

 
 
 

 
 

 
 

 

 
 

 
 

 
 

Gambar 2. 27. Objek Kontrol ke dalam Form 

 
 

 
 

 

 
 

 
 

 

Shape 
   TextBox   ComboBox    CommandButton      Line 
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Timer 

 ListBox            Grid                                  Image 
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3.  KOMPONEN UTAMA 
DALAM MENYUSUN 

                                                    SEBUAH APLIKASI 

 
 

 
Dalam menyusun sebuah aplikasi dengan Bahasa pemrograman Visual FoxPro diperlukan 

komponen-komponen utama, yaitu : 

 
1. Project 

2. Database File 

3. Startup File  

4. Form 

5. Report 

6. Menu 

 

Penjelasan. 
 

1. Project 
 

File : nama_file.pjx, nama_file.pjt 
 

Fungsi : Mengorganisasikan semua file yang dignakan untuk membuat aplikasi 
mnggunakan Bahasa Pemrograman Visual FoxPro sehingga semua file penyusun aplikasi 

terstruktur dalam hierarki yang jelas. Seperti cntoh dibawah ini nama projectnya adalah  

Maba_usn 
 

 
 

Gambar 3.1. Project Manager 
 

2. Database File 
 

Dalam Bahasa Pemrograman Visual FoxPro database terdiri atas 2 jenis, yaitu  : 
 

• Databases 

 
File:  nama_file.dbc, nama_file.dct, nama_file.dcx, nama_fil.dbf 
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Fungsi: Mengorganisasikan semua filr dbf (dbf) yang digunakan untuk aplikasi. 

Database seakan-akan merupakan root directory dari file-file data (dbf) yang terdapat 

dalam project. 
 

• Free Table 
 
File: nama_file.dbf, nama_file.cdx 
 

Fungsi: Menampung record-record yang berisi data dalam sebuah file (dbf). Bagian ini 
paling sering digunakan untuk memodifikasi database (menambahkan/mengurangi 

field-field sesuai dengan kebutuhan) 
 

 
 

Gambar 3.2. Contoh Struktur Database 
 

 
Seperti contoh diatas dalam Gambar 3.2, project diatas memiliki file Free Tables 

(maba.dbf) dengan field-field yang dibutuhkan. 

 
3. Startup File  

 
File: nama_file.prg, nama_file_file.fxp 
 

Fungsi: file yang dijalankan pertama kali oleh aplikasi berfungsi untuk loading seluruh 
database file terlibt dalam aplikasi. Seperti contoh dibawah ini, nama file startup 

programmnya adalah startup_mabausn 
 

 

 
 

Gambar 3.3. Contoh Startup File 
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4. Form 

 
File: nama_file.scx, nama_file.sct 
 
Fungsi: Mengelola record-record file dalam artian menambahkan record baru, 
menampilkan record yang sudah ada, mengedir record yang sudah ada, menghapus 

record yang sudah ada dan lain sebagainya. Seperti contoh di bawah ini, nama formnya 
adalah form_mabausn. 

 
 

 
 

Gambar 3.3. Contoh Form 
 

5. Report 

 
File: nama_file.frx, nama_file.frt 
 
Fungsi: Menghasilkan output dari pegolahan data kelayar ataupun untuk mencetak ke 

printer. Seperti contoh dibawah ini, nama reportnya adalah lap_maba. 
 

 
 

Gambar 3.4. Contoh Report 
 

6. Menu 
 

File: nama_file.mnx, nama_file.mpr 
 
Fungsi: Mengorganisasikan semua form yang terdapat dalam aplikasi supaya terstruktur 

dengan baik dan memudahkan pengoperasian oleh user. Seperti contoh dibawah ini, nama 
menunya adalah menu_mabausn. 

 
 

 
 

Gambar 3.5. Contoh Menu 
 

 

 



Bahasa Pemrograman Visual FoxPro        Oleh : Qammaddin, S.Kom 

 

Prodi Sistem Informasi                                - 18 -     Univ. 19 November Kolaka 

 

4.  PEMBUATAN PROJECT 
STARTUP PROGRAM, 

                                                  DAN MENU 

 
 
 

 Pengantar Umum 

 
Sebelum semua kegiatan pembuatan project, startup program dan menu untuk Aplikasi Data 

Mahasiswa Baru USN, harus diawali dulu dengan membuat folder dimana seluruh source code 
aplikasi ini akan ditempatkan. 

 

 
 

Gambar 4.1. Folder 
 
 
 

 Langkah - Langkah Setting Folder Kerja Aplikasi 

 

Setelah langkah-langkah pendahuluan seperti create folder, menentukan dimana letak folder untuk 
source code-nya. Langkah-lagkah setting folder sebagai berikut : 

 
1. Buka program Microsoft Visula FoxPro dengan mengklik tombol Start > All Programs > 

Micriosoft Visual FoxPro. 
 

2. Aturlah default direktori pada folder yang sudah dibuat seperti terlihat pada Gambar 4.1 

dengan cara sebagai berikut : 
• Klik menu Tools > Option.  

• Kemudian akan muncul kotak dialog Option , klik tab File Location dan klik Default 

Direktory sehinggan menjadi terpilih/tersorot seperti pada gambar dibawah ini. 
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Gambar 4.2. Kotak Dialog Option 
 

• Klik tombol Modify… sehingga muncul kotak dialog File Location sepeti gambar 

dibawah ini agar folder tersebut aktif. 

 

 
 

Gambar 4.3. Kotak Dialog File Location 
 

 
 Langkah - Langkah Penyusunan Project 

 

Dalam pembuatan project, diperlukan lagkah-langkah sebagai berikut : 
 

1. Klik menu File > New.… kemudian akan tampil kotak dialog New seperti pada Gambar 4.4. 
2. setelah kotak dialog tersebut nampak, klik tombol New File 

 
• Langkah-langkah yang dilakukan diatas merupakan adalah untuk membuat Project File 

baru untuk aplikasi supaya objek dan file database dapat terstruktur dengan baik 
sehinggan memudahkan penyusunan, pengeditan dan penelusuran kesalahan source code 

aplikasi 

 
 

Gambar 4.4. Kotak Dialog New 
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Gambar 4.5. Kotak Dialog Create 
 

3. Akan tampil kotak dialog create seperti dibawah ini. Pada kotak teks ‘Enter Project’ ketikkan 
nama project aplikasi, berinama project ini dengan ‘Maba_USN.pjx’ kemudian klik tombol Save 

kemudian akan muncul windows project manager seperti terlihat pada gambar beriku ini. 

 

 
 

Gambar 4.6. Project Manager – Maba_USN 
 

Pembuatan project untuk pembuatan aplikasi sudah selesai dengan menghasilkan file Project 
Maba_USN.pjx dan Project Maba_USN.pjt. File-file tersebut dapat dilihat dengan Windows 

Explorer pada direktori Maba USN.  
 

 

 Langkah - Langkah Penyusunan Startup Program 
 

Setelah selesai membuat project, akan dilanjutkan dengan pembuatan startup program, dimana 
startup program ini berfungsi untuk : 
• Menentukan seting-seting awal dari option-option yang ada dalam Bahasa Pemrograman Visual 

FoxPro, seperti setting bar menu utama loading menu, loading formutama dan sebagainya. 

• Inisialisasi dan Loading file-file database yang akan digunakan dalam aplikasi. 

• Menjalankan prosedur-prosedur dan menu untuk inisialisasi aplikasi. 
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Langkah-langkah pembuatan startup program adalah sebagai berikut : 

 

1. Pada windows project manager, klik tab Code sehingga tampil seperti gambar dibawah ini 
 

 
 

Gambar 4.7. Project Manager – Tab Code 
 

2. Klik programs kemudian klik tombol New sehingga tampil windows program seperti Gambar 

4.8. 
 

 
 

Gambar 4.8. Windows Program 
 
 

3. kemudian tekan tombol Ctrl+S untuk menyimpan file startup program. Untuk file startup 
program ini diberi nama startup_mabausn.prg. 

4. Setelah proses penyimpanan selesai, tutup windows program, dan pada window Program 

Manager akan tampak tampilan seperti berikut. 
 

 
 

Gambar 4.9. Tampilan pada Window Project Manager 
 

 
 

 



Bahasa Pemrograman Visual FoxPro        Oleh : Qammaddin, S.Kom 

 

Prodi Sistem Informasi                                - 22 -     Univ. 19 November Kolaka 

5. Kemudian klik tanda + yang terletak disebelah kiri programs (lihat Gambar 4.9) sehingga sub-

directory program diperluas (expand) dan file Startup_mabausn.prg yang dibuat tadi akan 

tampak seperti pada Gambar 4.10.  
 

 
 

Gambar 4.10. Tampilan pada Window Project Manager 
 

Pembuatan startup program untuk aplikasi sudah selesai dengan meghasilkan file 

Project_mabausn.prg. File-file tersebutdapat dilihat dengan Windows Explorer pada directory 
Maba USN. 

 
 

 Langkah - Langkah Penyusunan Menu 

 
Langkah-langkah pembuatan menu adalah sebagai berikut  : 

 
1. Pada window Project Manager klik tab Other kemudian klik pada Menus lalu klik tombol 

New. Setelah itu akan muncul window New Mane seperti tampak pada gambar berikut ini. 

 
 

Gambar 4.11. Window New Menu 
 

2. Klik tombol Menu dan muncul window Menu Designer seperti pada Gambar 4.12. 
 

 
 

Gambar 4.12. Window Menu Designer 
 

3. Simpan file menu Anda dengan menekan tombol Ctrl+S atau melalui Menu File > Save 

kemudian ketikan nama file menunya. Untuk aplikasi ini diberi nama menu_mabausn.mnx. 
dalam Window Explorer pada Directory Maba USN akan muncul 2 bah file menu, yaitu 

menu_mabausn.mnx dan menu_mabausn.mnt 
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4. Setelah file menu Anda simpan, untuk melihat seperti apa tampilan menu dalam aplikasi, tekan 

tombol Preview dan akan tampak seperti Gambar 4.13 
 

 
 

Gambar 4.13. Window Menu Preview 
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5.  PEMBUATAN APLIKASI 
     TABEL, FORM DAN  
      UNTUK APLIKASI  

      MABA USN 
                                                  

 
Dalam bab ini kita akan membahas pembuatan aplikasi rancangan Tabel (Table), rancangan 

Interface (form) dan Laporan (report). 

 
 

 Pendahuluan 
 

Perhatikan Gambar 5.1 yang menunjukan bagan alur pembuatan aplikasi data Mahasiswa Baru 

USN (Maba). 
 

Penjelasan bagan : 
 

• Sebelum membuat aplikasi entry Mahasiswa Baru USN (Maba), terlebih dahulu kita harus 

melakukan create file databasenya dengan struktur data yang akan dijelaskan berikutnya. 
• Setelah file databasenya sudah ada, file startup program harus diperbaharuyi untk 

menambhkan script dalam inisialisasi file database yang sudah di-create tadi. 

• Pada langkah selanjutnya, baru pembuatan bagian utama dari aplikasi dapat dikerjakan. 
 
 

 

 

 
 

 
 

 
 
 

 
 

 
 

 

 
 

 
 
 

 
 
 
 

Gambar 5.1. Bagan alur pembuatan aplikasi data mahasiswa baru USN 
 

• Trial aplikasi 

Jika proses trial terhadap aplikasi maksudnya membuktikan bahwa aplikasi tersebut sudah 

berjalan sempurna, lagkah selanjutnya adalah pembuatan file report sebagai output dari data 
yang sudah dimasukan pada aplikasi.  

 
• Trial report-report 

Jika proses trial terhadap report-report membuktikan bahwa report-reportnya sudah berjalan 

sempurna, file menu kita perbarui untk menambahakan modul aplikasi pada menu. 

 

Create file Table 
(MABA.dbf) untuk 
master data MABA 

 

Update Start-up Program 
(menambahkan inisialisasi file master 

data MABA 

 

Create Form Entry master data 
MABA beserta fasilitas-fasilitas pada 

form seperti delete record, edit 
record, find record by name, dsb. 

 

Create Report data MABA 

 

Trial Form Entry 
Data MABA 

Form & 
Report 
OK ? 

Error 
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5.2 Create File Database 

 

Untuk melakukan create file database, ikuti langkah-langkah berikut : 
 

1. Klik tab Data pada window Project Manager, kemudian klik Free Table seperti yang tampak 
pada gambar dibawah ini. 

 

 

 
 

Gambar 5.2. Project Manager-Tab Data 
 

 

 
 

 

Gambar 5.3. Kotak Dialog New Table 
 

 
2. Klik tobol New dan muncul kotak dialog New Table sepeti gambar 5.3. klik tombol New Table 

dan akan muncul kotak dialog create seperti gambar 5.4. 
3. Pada kotak teks Enter table name ketikan nama filenya, misal maba.dbf kemudian klik tombol 

Save. Setelah itu muncul window Table Designer sepeti Gambar 5.5. 
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Gambar 5.4. Kotak Dialog Create 
 
 

 
 

Gambar 5.5. Kotak Table Designer 
 

 
4. Pada window Table Designer, kita akan menentukan struktur data dari file tersebut.  

 

Filed Name Type Width Keterangan 

Nodaf Character 10 Nomor Pendaftaran 

Nm Character 30 Nama Pendaftar 

Ttl Character  40 Tempat dan tanggal lahir 

Jk Character 10 Jenis Kelamin 

Agm Character 10 Agama 

Alm Character 40 Alamat Pendaftar 

Tlp Character 25 No. Tlp Pendaftar 

Asal_sek Character 15 Asal Sekolah Pendaftar 

Jur Character  10 Jurusan SMA 

Tgl Date 8 Tanggal Daftar 

Fak Character 25 Fakultas 

Prodi Character 20 Program Studi 
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Gambar 5.6. Macam-macam type data pada window Table Designer 
 

5. Dalam Bahasa Poemrograman Visual Foxpro terdapat 14 jenis type data ( seperti yang tampak 

pada Gambar 5.6 diatas, namun yang serng dipakai dalam aplikasi ini adalah Character, 
Numeric dan Date. 

 
6. Pada window Tabl Designer klik tab Indexes untuk membuat index dengan nama NODAF. 

Field kode index ini berfungsi pada waktu kita membuat baplikasi untuk mencari data dengan 

kata kunci nodaf. 
 

 
 

Gambar 5.7. Window Table Designer – Tab Indexes 
 
7. Pada Free Table terdapat 2 jenis type indexes (seperti yang tampak 5.7 diatas), yaitu 

Candidate dan Regular. 
Namun yang sering dipakai dalam aplikasi ini adalah type Indexes Regular. Jika inin memakai 

type indexes candidate, sebenarnya juga bisa, malah lebih membantu karena type Candidate 

secara otomatis  akan mengetahui jikalau ada ulpikasi data kode. 
8. Setelah langkah diatas selesai, kembali ke tab Fields untuk melihat apakah index anda sudah 

berhasil atau tidak dan juga untuk mengubah aturan index.dalam option defaultnya, aturan 
index secara Ascending (Kecil ke Besar) tetapi dapat juga anda ubah menjadi Descending 

(Besar ke kecil), seperti pada Gambar 5.8. 
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9. Klik tombol OK untuk menyimpan struktur file database yang sudah dibuat atas. 

 

 
 

Gambar 5.8. Window Table Designer – Ascending/Descending Indexes 
 

10. Dalam Project Manager pada Tab Fields akan tampak seperti gambar dibawah ini secara 
berurutan (gambar 5.9, Gambar 5.10, gambar 5.11). 

 

 
 

Gambar 5.9. 
 
 

 
 

Gambar 5.10. 
 
 

 
Gambar 5.11. 

 

Prose pembuatan file database selesai dengan menghasilkan file maba.dbf dan maba.cdx. 
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5.3 Update Startup Program 

 

Pada window project manager klip tab Code, akan tampil seperti gambar dibawah ini. 
 

 
Gambar 5.12 

 

Selanjutnya klik pada ‘startup_mabausn’ kemudian klik tombol Modify. Dan akan muncul window 
startup_mabausn.prg. 

 

 
 

Gambar 5.13. Window startup_mabausn.prg 
 

 

5.4 Create Aplikasi Entry (Input), Edit dan Delete Record (Hapus) 
 

Untuk objek-objek, seperti form, report dan label, semua terdapat dalam tab Document. Jaaadi 
dalam bagian ini kita akan banyak berada dalam tab Documen. 
 

 
 

Gambar 5.14. Project Manager – Tab Document 
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5.5 Pembuatan Tampilan Form (Interface) dan Source Code 

 

Lankah-langkah pembuatan tampilan form adalah sebagai berikut : 
 

 
 

Gambar 5.15. Kotak Dialog New Form 
 

1. Klik tombol New pada project manager kemudian muncul kotak dialog New Form seperti 
Gambar 5.15. Kemudian klik tombol New Form dan form baru akan muncul, tetapi masih 

dalam bentuk balank seperti gambar dibawah ini 

 

 
 

Gambar 5.16. Form Designer-FormDoc1 
 
 

 Masukkan Objek-objek control ke dalam Form INPUT yang dibutuhkan sesuai dengan 

tabel yang telah kita rancang sebelumnya. Gunakan objek control Label, TextBox, 
ComboBox, Shape dan CommandButton. Sehingga hasil rancangan form tampak pada 
gambar berikut ini. 

 

 
 

Gambar 5.17. Form Designer - Input_mabausn.scx 
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Setelah objek-objek dimasukkan ke dalam form (lihat Gambar 5.17), masukkan instruksi 

program pada tiap-tiap objek tersebut. 

 
• Object : Form1    Procedure : Load 

SET DATE ITALIAN  
USE maba 
SET ORDER TO nodaf  

 

• Object : Form1    Procedure : Unload 

CLOSE DATABASES  
CLOSE INDEXES 

 
• Object : nm    Procedure : Gotfocus 

IF !EMPTY(THISFORM.NODAF.Value) 

SEEK ALLTRIM(THISFORM.nodaf.Value) 

IF FOUND() 
 pesan=MESSAGEBOX("Maaf, No. Daftar"; 

+(THISFORM.nodaf.Value)+"Sudah Ada",16,"Pesan Salah") 
 IF pesan=1 

 thisform.nodaf.SetFocus 
ELSE 

 thisform.nodaf.Value="" 

 thisform.nm.Value="" 
 thisform.ttl.Value="" 

 thisform.jk.Value="" 
 thisform.agm.Value="" 

 thisform.alm.Value="" 

 thisform.tlp.Value="" 
 thisform.asal_sek.Value="" 

 thisform.jur.Value="" 
 thisform.tgl.Value=CTOD("--") 

 thisform.fak.Value="" 
 thisform.prodi.Value="" 
 thisform.nodaf.SetFocus 

ENDIF 
ENDIF 

 
• Object : Command1   Procedure : Click 

with thisform 

IF EMPTY(.nodaf.Value) 

 MESSAGEbox("Masukan No daftar dulu boss..","Konfirm")  
 .nodaf.SetFocus  

ELSE 
no=alltrim(.nodaf.value) 

seek(no) 
pesan=messagebox("Data Akan Di Rekam",4+64,"Konfirmasi")=6 

   if pesan=1 

      append blank 
    replace nodaf WITH thisform.nodaf.Value 

  replace nm WITH thisform.nm.Value  
 replace ttl WITH thisform.ttl.Value  

 replace jk WITH thisform.jk.Value  

 replace agm WITH thisform.agm.Value  
 replace alm WITH thisform.alm.Value  

 replace tlp WITH thisform.tlp.Value  
 replace asal_sek WITH thisform.asal_sek.Value  

 replace jur WITH thisform.jur.Value  

 replace tgl WITH thisform.tgl.Value  



Bahasa Pemrograman Visual FoxPro        Oleh : Qammaddin, S.Kom 

 

Prodi Sistem Informasi                                - 32 -     Univ. 19 November Kolaka 

 replace fak WITH thisform.fak.Value  

 replace prodi WITH thisform.prodi.Value  

 
   thisform.nodaf.Value="" 

 thisform.nm.Value="" 
 thisform.ttl.Value="" 
 thisform.jk.Value="" 

 thisform.agm.Value="" 
 thisform.alm.Value="" 

 thisform.tlp.Value="" 
 thisform.asal_sek.Value="" 

 thisform.jur.Value="" 

 thisform.tgl.Value=CTOD("--") 
 thisform.fak.Value="" 

 thisform.prodi.Value="" 
 thisform.nodaf.SetFocus 

ELSE 
 thisform.nodaf.Value="" 

 thisform.nm.Value="" 

 thisform.ttl.Value="" 
 thisform.jk.Value="" 

 thisform.agm.Value="" 
 thisform.alm.Value="" 

 thisform.tlp.Value="" 

 thisform.asal_sek.Value="" 
 thisform.jur.Value="" 

 thisform.tgl.Value=CTOD("--") 
 thisform.fak.Value="" 

 thisform.prodi.Value="" 
 thisform.nodaf.SetFocus 

ENDIF 

ENDIF 
endwith 

 
• Object : Command2   Procedure : Click 

 thisform.nodaf.Value="" 

 thisform.nm.Value="" 

 thisform.ttl.Value="" 
 thisform.jk.Value="" 

 thisform.agm.Value="" 
 thisform.alm.Value="" 

 thisform.tlp.Value="" 

 thisform.asal_sek.Value="" 
 thisform.jur.Value="" 

 thisform.tgl.Value=CTOD("--") 
 thisform.fak.Value="" 

 thisform.prodi.Value="" 
 thisform.nodaf.SetFocus 

 

• Object : Command3    Procedure : Click 

BROWSE NOEDIT 
thisform.nodaf.setfocus 

 
• Object : Command4    Procedure : Click 

    thisform.Release 
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Sebelum kita melangkah lebih lanjut, form tersebut dapat disimpan terlebih dahulu dengan 

menekan Ctrl+S atau dapat juga lewat menu File > save. Kemudian ketikan nama formnya 

pada kota dialog File Save dengan nama input_mabausn.scx. 
 

 
 

 Masukkan Objek-objek control ke dalam Form EDIT yang dibutuhkan sesuai dengan tabel 

yang telah kita rancang sebelumnya. Gunakan objek control Label, TextBox, ComboBox, 
Shape dan CommandButton. Sehingga hasil rancangan form tampak pada gambar berikut 
ini. 

 
 

Gambar 5.18. Form Designer - Edit_mabausn.scx 
 

Setelah objek-objek dimasukkan ke dalam form (lihat Gambar 5.18), masukkan instruksi 
program pada tiap-tiap objek tersebut. 

 

• Object : Form1    Procedure : Load 

SET DATE ITALIAN  

USE maba 

SET ORDER TO nodaf  
 

• Object : Form1    Procedure : Unload 

CLOSE DATABASES  
CLOSE INDEXES 

 

• Object : nm    Procedure : Gotfocus 

IF !EMPTY(THISFORM.NODAF.Value) 
SEEK ALLTRIM(THISFORM.nodaf.Value) 

IF FOUND() 
 thisform.nodaf.Value=nodaf 

 thisform.nm.Value=nm 
 thisform.ttl.Value=ttl 

 thisform.jk.Value=jk 

 thisform.agm.Value=agm 
 thisform.alm.Value=alm 

 thisform.tlp.Value=tlp 
 thisform.asal_sek.Value=asal_sek 

 thisform.jur.Value=jur 

 thisform.tgl.Value=tgl 
 thisform.fak.Value=fak 
 thisform.prodi.Value=prodi 
 thisform.nodaf.SetFocus 

ELSE 
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 MESSAGEBOX("Maaf, No. Daftar  "+(THISFORM.nodaf.Value)+" Belum 

Ada",16,"Pesan Salah") 

 thisform.nodaf.SetFocus 
ENDIF 

ENDIF 
 

• Object : Command1   Procedure : Click 

with thisform 

IF EMPTY(.nodaf.Value) 
 MESSAGEbox("Masukan No daftar dulu boss..","Konfirm")  

 .nodaf.SetFocus  
ELSE 

no=alltrim(.nodaf.value) 

seek(no) 
pesan=messagebox("Data Akan Di Rekam",4+64,"Konfirmasi")=6 

   if pesan=1 
    replace nodaf WITH thisform.nodaf.Value 

  replace nm WITH thisform.nm.Value  
 replace ttl WITH thisform.ttl.Value  

 replace jk WITH thisform.jk.Value  

 replace agm WITH thisform.agm.Value  
 replace alm WITH thisform.alm.Value  

 replace tlp WITH thisform.tlp.Value  
 replace asal_sek WITH thisform.asal_sek.Value  

 replace jur WITH thisform.jur.Value  

 replace tgl WITH thisform.tgl.Value  
 replace fak WITH thisform.fak.Value  

 replace prodi WITH thisform.prodi.Value  
   thisform.nodaf.Value="" 

 thisform.nm.Value="" 
 thisform.ttl.Value="" 

 thisform.jk.Value="" 

 thisform.agm.Value="" 
 thisform.alm.Value="" 
 thisform.tlp.Value="" 
 thisform.asal_sek.Value="" 

 thisform.jur.Value="" 

 thisform.tgl.Value=CTOD("--") 
 thisform.fak.Value="" 

 thisform.prodi.Value="" 
 thisform.nodaf.SetFocus 

ELSE 

 thisform.nodaf.Value="" 
 thisform.nm.Value="" 

 thisform.ttl.Value="" 
 thisform.jk.Value="" 

 thisform.agm.Value="" 
 thisform.alm.Value="" 

 thisform.tlp.Value="" 

 thisform.asal_sek.Value="" 
 thisform.jur.Value="" 

 thisform.tgl.Value=CTOD("--") 
 thisform.fak.Value="" 

 thisform.prodi.Value="" 

 thisform.nodaf.SetFocus 
ENDIF 

ENDIF 
endwith 
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• Object : Command2   Procedure : Click 

 thisform.nodaf.Value="" 

 thisform.nm.Value="" 
 thisform.ttl.Value="" 
 thisform.jk.Value="" 
 thisform.agm.Value="" 

 thisform.alm.Value="" 

 thisform.tlp.Value="" 
 thisform.asal_sek.Value="" 

 thisform.jur.Value="" 
 thisform.tgl.Value=CTOD("--") 

 thisform.fak.Value="" 

 thisform.prodi.Value="" 
 thisform.nodaf.SetFocus 

 
• Object : Command3    Procedure : Click 

BROWSE NOEDIT 

thisform.nodaf.setfocus 
 

• Object : Command4    Procedure : Click 

thisform.Release 

 
Sebelum kita melangkah lebih lanjut, form tersebut dapat disimpan terlebih dahulu dengan 

menekan Ctrl+S atau dapat juga lewat menu File > save. Kemudian ketikan nama formnya 
pada kota dialog File Save dengan nama edit_mabausn.scx. 

 

 
 Masukkan Objek-objek control ke dalam Form HAPUS yang dibutuhkan sesuai dengan 

tabel yang telah kita rancang sebelumnya. Gunakan objek control Label, TextBox, 
ComboBox, Shape dan CommandButton. Sehingga hasil rancangan form tampak pada 
gambar berikut ini. 

 

 
 

Gambar 5.19. Form Designer - Hapus_mabausn.scx 
 

Setelah objek-objek dimasukkan ke dalam form (lihat Gambar 5.19), masukkan instruksi 

program pada tiap-tiap objek tersebut. 
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• Object : Form1    Procedure : Load 

SET DATE ITALIAN  

USE maba 

SET ORDER TO nodaf  
 

• Object : Form1    Procedure : Unload 

CLOSE DATABASES  
CLOSE INDEXES 

 

• Object : nm    Procedure : Gotfocus 

IF !EMPTY(THISFORM.NODAF.Value) 
SEEK ALLTRIM(THISFORM.nodaf.Value) 

IF FOUND() 
 thisform.nodaf.Value=nodaf 

 thisform.nm.Value=nm 

 thisform.ttl.Value=ttl 
 thisform.jk.Value=jk 

 thisform.agm.Value=agm 
 thisform.alm.Value=alm 

 thisform.tlp.Value=tlp 
 thisform.asal_sek.Value=asal_sek 

 thisform.jur.Value=jur 

 thisform.tgl.Value=CTOD("--") 
 thisform.fak.Value=fak 

 thisform.prodi.Value=prodi 
 thisform.nodaf.SetFocus 

ELSE 

 MESSAGEBOX("Maaf, No. Daftar  "+(THISFORM.nodaf.Value)+" Belum ; 
Ada",16,"Pesan Salah") 

 thisform.nodaf.SetFocus 
ENDIF 

ENDIF 
 
 

 
• Object : Command1   Procedure : Click 

IF EMPTY(thisform.nodaf.Value) 

 MESSAGEbox("Masukan No Daftar dulu boss..","Konfirm")  
 thisform.nodaf.SetFocus  

ELSE 

if messagebox("Yakin Akan Menghapus Data Pendafatar..?",4+48,"Pesan")=6 
   delete 

   pack 
ENDIF 

ENDIF 
 thisform.nodaf.Value="" 

 thisform.nm.Value="" 

 thisform.ttl.Value="" 
 thisform.jk.Value="" 

 thisform.agm.Value="" 
 thisform.alm.Value="" 

 thisform.tlp.Value="" 

 thisform.asal_sek.Value="" 
 thisform.jur.Value="" 

 thisform.tgl.Value=CTOD("--") 
 thisform.fak.Value="" 

 thisform.prodi.Value="" 

 thisform.nodaf.SetFocus 
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• Object : Command2   Procedure : Click 

 thisform.nodaf.Value="" 

 thisform.nm.Value="" 
 thisform.ttl.Value="" 
 thisform.jk.Value="" 
 thisform.agm.Value="" 

 thisform.alm.Value="" 

 thisform.tlp.Value="" 
 thisform.asal_sek.Value="" 

 thisform.jur.Value="" 
 thisform.tgl.Value=CTOD("--") 

 thisform.fak.Value="" 

 thisform.prodi.Value="" 
 thisform.nodaf.SetFocus 

 
• Object : Command3    Procedure : Click 

BROWSE NOEDIT 

thisform.nodaf.setfocus 
 

• Object : Command4    Procedure : Click 

thisform.Release 
 

 

Sebelum kita melangkah lebih lanjut, form tersebut dapat disimpan terlebih dahulu dengan 
menekan Ctrl+S atau dapat juga lewat menu File > save. Kemudian ketikan nama formnya 

pada kota dialog File Save dengan nama input_mabausn.scx. 
 
 
 

2. Pada project manager di tab Documents akan tampak seperti gambar-gambar dibawah ini. 
(Gambar5.20 dan Gambar 5.21) untuk Form Input, Edit, Hapus. 

 

 
 

Gambar 5.20. 
 

 
 

Gambar 5.21. 
 

3. Rancangan interface form aplikasi data Mahasiswa Baru (Maba) USN telah selesai. Jalankan 

program yang telah anda rancang (Run) dengan menekan tombol  (tanda seru). 

 
 

 
5.6 Pembuatan Report untuk Procedure Print dan Preview pada Form Data Maba 

USN 
 

Langkah-langkah pembuatan report untuk procedure Print dan Preview pada Form Data Calon 

Mahasiswa Baru (Maba) adalah sebagai berikut : 
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Gambar 5.22. Window Project tab Documents - Reports 
 

1. Pada window Project manager tab Documents, klik Reports kemudian klik tombol New. 
Setelah itu muncul kotak dialog New Reports dan klik tombol New Rport. 

 

 
 

Gambar 5.23. kotak doalig New Report 
 
2. Akan muncul window Report Designer seperti dibawah ini. 
 

 
 

Gambar 5.24. Wondow Report Designer 
 
 

3. Masukkan file database yang ada kedalam Window Report Designer melalui View > Data 
Environmen. Dan melalui Data Environmen klik kanan dan Add (masukan databasenya) 

sehingga hasilonya tampak pada gambar berikut ini (Gabar 5.25 dan 5.26). 
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Gambar 5.25.  
 

 
 

Gambar 5.26.  
 
 

Dengan demikian telah selesailah pembuatan program aplikasi Data calon Mahasiswa Baru. Untuk 
lebih jelasnya anda dapat lihat Lampiran 2 pada buku ini. 
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LAMPIRAN  1 
 
 
 

Diagram Konteks  
Sistem Pengolahan Data Mahasiswa Baru (Maba) 

Universitas 19 November Kolaka. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 

 
 

 

 
 

Data pendaftar 
 
 

  Formulir Pendaftaran 
Alumni 

Data Maba          Data Maba 
 

Laporan                 Laporan 
 

 
 

Sistem 
Pengolahan 
Data Maba 

0  

Pendaftar 

 

BAK 

F      Maba .dbf 

 

PR 
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LAMPIRAN 2 
 
 

FORM APLIKASI SECARA RINCI 

 
 

1. Menu Utama Aplikasi Penerimaan Mahasiswa Baru 
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2. Form Input Data Mahasiswa Baru 
 

 
 

 
3. Form Edit Mahasiswa Baru 
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4. Form Hapus data Mahasiswa Baru 

 

 


